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Chronos. Your rights to the software are governed by the accompanying software license agreement.
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Chapter 1—Welcome

iClipboard is the ultimate clipboard manager. It keeps a history of everything you copy to the system-wide clip-
board from any application. When you need to go back and paste a clipping from the history, iClipboard ap-
pears from the side of your screen so you can preview and paste any clipping—you're no longer limited to 
pasting just the last thing copied to the clipboard. For a list of new features in this version please visit our web 
site at http://www.chronosnet.com. 

System Requirements
✦ Mac OS X v10.5 or later 
✦ 20MB of available disk space
✦ DVD-ROM drive for installation 

Installing iClipboard
To install the software from a DVD:

1) Insert the installation DVD into your computer’s optical drive.

2) Drag and drop the iClipboard application icon into your Applications folder or other folder of your choice.

To install the software from a download:

1) Open the iClipboard disk image on your desktop

2) Drag and drop the iClipboard application icon into your Applications folder or other folder of your choice.

What Gets Installed?

The first time you run iClipboard, the following items will be installed on your hard disk.

✦ iClipboard.prefPane alias. This alias file links to the iClipboard preference pane inside the iClipboard applica-
tion. The iClipboard preference pane shows up in the Mac OS X System Preference application. The alias file is 
located in the “PreferencePanes” folder of your home “Library” folder.

Uninstall iClipboard

The below steps describe how to uninstall all of the components related to iClipboard.

1) Delete the iClipboard application. The iClipboard application was originally installed by you, so you are the only 
one that knows where it is installed. That said, it is likely in your Applications folder.

2) Delete the “Chronos/iClipboard” folder. This folder is where iClipboard stores its database. This is located in the 
“Application Support” folder of your home Library folder.

3) Delete the “iClipboard.prefPane” alias file. This is located in the “PreferencePanes” folder of your home Library 
folder.

4) Delete the “com.chronos.iClipboard.plist” file. This file is located in the “Preferences” folder of your home Library 
folder.
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Learning to Use iClipboard 
To learn how to use iClipboard, consult these resources: 

User’s Guide 

This guide describes iClipboard’s features and shows how to use the program.

Onscreen Help 

Help tags are available for many of the items in iClipboard. To see the help tags, let the mouse pointer rest over 
an item for a couple of seconds. 

Technical Support 

Chronos provides various support options for iClipboard. See http://www.chronosnet.com/Support/index.html 
for technical support options. 

Web Resources 

Go to http://www.chronosnet.com/Products/index.html to get the latest software and updates.
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Chapter 2—Getting Started

iClipboard is little bit unique in that it’s a faceless background application. This means it doesn’t appear in the 
Mac OS X Dock and doesn’t have a menu bar. Instead it runs in the background and only appears when needed.

Launching iClipboard The First Time
The first time you launch iClipboard it performs some basic installation chores and setup. Once this initial setup 
has been done, you will be able to launch and quit iClipboard using the iClipboard preference pane (see the 
next section).

To launch iClipboard the very first time:

1) Double-click the iClipboard application. The application will launch and a tab will appear on the edge of the 
screen.

2) Click the tab. The tab is connected to a window called the Shelf which is described in the next chapter.

 

The first time you launch iClipboard, it is automatically added to the list of Login Items for your user account. 
This means that iClipboard will automatically and conveniently launch each time you restart your computer.

To view/edit your user account’s Login Items:

1) Open the System Preferences.

2) Click the Accounts preference pane.
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3) Select your account.

4) Click the Login Items tab.

Quitting and Launching iClipboard
Because iClipboard is a background application, you can’t quit it from the File menu like you would for most 
applications. Instead, you use the iClipboard preference pane to quit and launch iClipboard

To quit or launch iClipboard:

1) Open the System Preferences.

2) Click the iClipboard preference pane.

3) Move the ON/OFF switch to the OFF position to quit iClipboard. Move the switch to the ON position to launch 
iClipboard.

Changing Whether iClipboard Launches at System 
Startup
You can change at any time whether or not you want iClipboard to be launched automatically whenever your 
computer restarts.

To enable or disable iClipboard launching at system startup:

1) Open the System Preferences.

2) Click the iClipboard preference pane.

3) Select or deselect Enable at system startup.
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Chapter 3—Using iClipboard

iClipboard records everything copied to the system-wide clipboard  (whenever you press Command-C or choose 
Edit > Copy in any application). It will also remember everything copied between computer restarts, so you can 
literally go back weeks in time to find something that you copied. Each recorded item  is called a clipping. 

The Shelf
The Shelf, which appears on the edge of your screen, lists all of the clippings that have been recorded. 

Each clipping appears as a thumbnail that represents the content in the clipping. iClipboard can accurately pre-
sent thumbnails for standard clippings like the following:

✦ Text (including rich text)
✦ Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
✦ Web content (html/web archives)
✦ Movies
✦ Audio
✦ Files
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If iClipboard encounters a non-standard or proprietary clipping, the following thumbnail will appear:

This symbol simply means that iClipboard can’t display the contents of the clipping, but the clipping is still valid 
and every bit as usable as any other clipping.

To open the Shelf and view the clippings:

1) Click the tab on the Shelf. The Shelf will slide out from the side of the screen.

To close the Shelf:

1) Click the tab on the open Shelf. The Shelf will slide closed.

To change the position of the Shelf on the screen:

1) Click the Action button and choose Preferences.

2) Choose a new screen position from the Position pop-up menu.

To change the width of the Shelf on the screen:

1) Click the Action button and choose Preferences.

2) Adjust the width slider accordingly.

To change the behavior of how the Shelf opens/closes:

Normally, the Shelf opens/closes by clicking on its tab. You can, however, change this behavior so the Shelf 
opens when you move your mouse to the edge of the screen and closes when you move your mouse off of the 
Shelf.

1) Click the Action button and choose Preferences.

2) Select Turn hiding on

Adding Clippings
iClipboard automatically records everything copied to the system-wide clipboard. The means whenever you press 
Command-C or choose Edit > Copy in any application, the copied content is recorded by iClipboard and placed on 
the Shelf. But there are other ways to get content onto the Shelf including dragging content to Shelf and using the 
controls within a clipping to grab selected content.

To drag content to the Shelf:

1) Click and drag content from any application to Shelf. If the Shelf is closed, it will automatically open and you can 
drop the content on any current clipping. The clipping will be replaced with the new content.

To control how the Shelf opens when dragging content to the Shelf:

If the Shelf is closed when you drag content to it, the Shelf will need to open automatically for you. You can 
choose to have the Shelf open automatically as soon as the mouse is over the Shelf’s tab or as soon as the 
mouse hits the edge of the screen.
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1) Click the Action button and choose Preferences.

2) Choose either the Dock Tab or Screen Edge option.

To replace a clipping with selected content in the current application:

1) Select some content in your application.

2) Open the Shelf

3) Move your mouse over an existing clipping whose contents you want replaced with the selected content from 
another application. A control bar will appear inside the clipping.

4) Click the Grab button.

Deleting Clippings
The occasion may arise when you want to delete a single clipping from the Shelf (like a password) or clear the entire 
history of recorded clippings.

To delete a clipping:

1) Move your mouse over an existing clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Delete.

To delete all clippings:

1) Click the Action button and choose Clear.

Pasting a Clipping Into Another Application
iClipboard keeps a history of everything copied to the system-wide clipboard so you can go back at any time 
and use the clippings again. iClipboard makes it easy to paste a clipping into another application.

To paste a clipping into another application:

1) Switch to the application where you want the clipping pasted and then click in the document where you want 
the clipping pasted.

2) Open the Shelf.

3) Move your mouse over the clipping you want to paste. A control bar will appear inside the clipping.

4) Click the Paste button.
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Previewing a Clipping
The Shelf only displays a thumbnail view of each clipping since space is limited. If you need to see a larger ver-
sion of a clipping, you can bring up a preview.

iClipboard can show you previews of the following standard types of clippings:

✦ Text (including rich text)
✦ Graphics (supports all popular formats including jpeg, tiff, png, pdf, eps, etc.)
✦ Web content (html/web archives)
✦ Movies
✦ Audio
✦ Files

The previews are dynamic in that movies and audio will play, and files will show you a Mac OS X Quick Look 
preview of the file’s contents when available. If iClipboard tries to preview a non-standard or proprietary clip-
ping, the following preview symbol will appear:

This symbol simply means that iClipboard can’t display the contents of the clipping, but the clipping is still valid 
and every bit as usable as any other clipping.

The preview will also show you other pertinent information about the clipping depending upon the type of 
clipping:

✦ The type of clipping (text, graphic, movie, etc.)
✦ The size of the clipping in bytes
✦ The document and application where the clipping came from
✦ The URL where the web clipping came from, i.e. www.chronosnet.com
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✦ The date and time the clipping occurred

To control when previews appear:

You can control when previews appear depending upon your own likes/dislikes. You can choose to have the 
preview appear when your mouse rests above a clipping for a short period of time or when you click the clip-
ping.

1) Click the Action button and choose Preferences.

2) Choose your desired option from the Show Preview pop-up menu.

To preview a clipping:

1) Move your mouse over a clipping or click the clipping (depending upon your preference setting).

To dismiss a clipping:

1) Move your mouse outside the preview window or Shelf and the preview will momentarily dismiss.

Pausing/Resuming Recording
There may be times when you don’t want iClipboard to record data that is copied to the system-wide clipboard. 
In such cases, you can temporarily pause and resume recording from the Shelf with a single click.

To pause recording:

1) Click Pause.

To resume recording:

1) Click Resume.

Opening a Clipping
You can open a clipping in another application if you want to edit the clipping or work with it. iClipboard will 
open the clipping using the default application for the type of data stored in the clipping. For example, a rich 
text clipping will most likely be opened by TextEdit; a jpeg image will most likely be opened by Preview or 
other graphics editing program; and so forth.

To open a clipping:

1) Move your mouse over an existing clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Open.

Editing Text Clippings
You can edit a text clipping directly from the Shelf. This is useful if you need to make a correction or change to a 
clipping before pasting it into another application.

To edit a text clipping:

1) Move your mouse over an existing text clipping. A control bar will appear inside the clipping.

2) Click the Action button in the control bar and choose Edit.
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Setting Limits
iClipboard can conceivably record every clipping copied to the clipboard forever. As you might imagine, doing 
so would consume a lot of memory and disk space. Fortunately, iClipboard lets you limit the total number of 
clipping by quantity or by time period. For example, you can tell iClipboard to only record the most recent 100 
clippings or you can tell iClipboard to only keep clippings from the past week.

You may also want iClipboard to ignore clippings if they are exceedingly large. For example, a graphics designer 
that works with large graphic files may not want iClipboard to record a 50MB image. Likewise, a movie editor 
might not want a 400 MB movie clip recorded since doing so may affect the computer’s performance. iClip-
board lets you choose to record all clippings regardless of size or just those below a certain size.

To limit the total number of recorded clippings:

1) Click the Action button and choose Preferences.

2) Choose a limit from the Clipboard limit pop-up menu.

To limit the size of clippings that are recorded:

1) Click the Action button and choose Preferences.

2) Choose a limit from the Ignore clippings pop-up menu.

Setting Grab and Paste Sounds
Whenever you grab content onto the Shelf (either by dragging or the Grab button), a special grab sound will 
play so you know the content was grabbed. Likewise, whenever you paste a clipping into another application, a 
special paste sound will play. You can change the sound that plays when these events occur or you can turn off 
the sound effect altogether.

To change the grab and paste sounds:

1) Click the Action button and choose Preferences.

2) Choose a new sound from the sound pop-up menus.
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Chapter 4—Projects

iClipboard can record and group clippings into projects that you define. For example, a scientist might switch to 
her  Research project when she’s doing research on the web and switch to her Report project when she’s work-
ing on weekly progress reports. Projects make it possible to compartmentalize your work.

The Project button at the top of the Shelf indicates the project that you’re currently recording into. The Shelf 
shows you all the clipping in the currently selected project.

The default project is “All” which indicates that the Shelf is showing every clipping regardless of which project it 
belongs to. In other words, “All” represents the master history of clippings. When “All” is selected and a clipping 
is recorded, the clipping is not assigned to any project.

To add a new project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Click Add (+). A new project will be added to the list of projects.

3) Enter the name of your project and press Return.

4) Click Done to exit the sheet.

To delete a project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Select a project in the list.

3) Click Delete (-).

4) Click Done to exit the sheet.

To rename an existing project:

1) Choose Edit Projects from the Projects pop-up menu. A sheet for editing projects will appear.

2) Double-click a project in the list.

3) Edit the name of the project and press Return.

4) Click Done to exit the sheet.

To switch projects:

1) Choose a project from the Projects pop-up menu. The Shelf will display all of the clippings that have already 
been recorded to the selected project.
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